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1. Introduction to the Division of Medical Quality Assurance’s Data 

The Florida Department of Health Division of Medical Quality Assurance provides licensure and 
healthcare practitioner data to the public through the Search Services website and the Data 
Download Portal. Search Services is tailored to members of the public that are seeking to locate 
specific information pertaining to healthcare professionals, while the Data Download Portal 
provides large data sets that are best suited for business or research purposes.   

2. MQA’s Search Services 

MQA’s Search Services provides a centralized platform for accessing information on healthcare 
professionals licensed by the Florida Department of Health. This tool enables users to verify 
licensure, review disciplinary actions, and access a range of public records, supporting 
transparency and informed decision-making. 

The search portal is designed to facilitate efficient searches and provide accurate, up-to-date 
information. Users are encouraged to utilize the platform’s features to meet their specific 
informational requirements. 

2.1 Home 

Search Services portal provides public access to data on healthcare practitioners and facilities 
in Florida. Users can search for license verifications, practitioner profiles, disciplinary actions, 
and administrative data for various healthcare roles and establishments. It serves to ensure 
transparency and accessibility of information related to the professional standards and 
disciplinary history of healthcare providers across the state. 
 

 
 

2.2 License Verification  

Users can use the License Verification search feature to confirm the licensure status of 
practitioners (e.g., doctors, nurses, paramedics) and establishments (e.g., pharmacies, 

https://mqa-internet.doh.state.fl.us/MQASearchServices/Home
https://mqa-internet.doh.state.fl.us/MQASearchServices/HealthCareProviders/PractitionerProfileSearch
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massage establishments) to ensure they are authorized to operate in Florida. In addition to 
Board and Profession, users can also search by license number, name, city, county, and zip 
code.  
 
Users of Search Services License Verification can search “All Statuses”, “Practicing Statuses”, 
or “Non-Practicing Statuses.” From the Results page, users can select individual licensees 
and see additional license information as well as address of record, and whether the licensee 
has discipline on file or any public complaints. The results can be exported in a CSV file. 
 

 

 

2.3 Practitioner Profile  

The Practitioner Profile summarizes data submitted by the practitioner. This data has not been 
verified by the Department unless otherwise indicated.  
 
MQA’s Search Services Practitioner Profile Search is typically used to find additional 
information about a specific practitioner or a group of similar practitioners. In addition to Board 
and Profession, users can also search by specialty or certification, license number, name, city, 
county, and zip code. From the Results page, users can select individual licensees and see 
additional profile information about that specific practitioner. The results can be exported in a 
CSV file. 
 
Only the following professions are required to report profile data to DOH:  

• Medical Doctors 
• Osteopathic Physicians 
• Podiatric Physicians 
• Advanced Practice Registered Nurses 
• Chiropractic Physicians.  

 
The data required to be provided by the practitioner includes: 

• Practitioner's education and training, including other health related degrees, 
professional and post graduate training specialty 

• Practitioner's current practice and mailing addresses 
• Practitioner's staff privileges and faculty appointments 

https://mqa-internet.doh.state.fl.us/MQASearchServices/HealthCareProviders/PractitionerProfileSearch
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• Practitioner's reported financial responsibility 
• Legal actions taken against the practitioner 
• Board final disciplinary action taken against the practitioner 
• Any liability claims filed against podiatric physicians which exceed $5,000 
• Any liability claims filed against allopathic and osteopathic physicians which exceed 

$100,000. 
 
The data provided may also include optional information such as committees, memberships, 
and publications.  
 

 
 

 

2.4 Discipline and Administrative Actions  

The Discipline and Administrative Actions search platform provides access to records of 
disciplinary actions or administrative proceedings taken against practitioners or 
establishments, promoting informed decision-making. 
 

 

https://mqa-internet.doh.state.fl.us/MQASearchServices/EnforcementActionsPractitioner
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2.5 Nursing Education Programs  

Information about approved nursing education programs in Florida is available on the 
Compare Florida Prelicensure Nursing Education Programs search platform, assisting 
prospective students in making informed choices. It provides two methods to compare Florida 
Prelicensure Nursing Education Programs. You can select View List and see all listed 
programs. You may also Search by entering specific criteria. With either method, you can later 
select which programs you would like to compare. 
 

 
 

2.6 Prescription Pad Vendors  

A list of approved vendors for prescription pads is provided, ensuring compliance with state 
regulations. 
 

 
 
 

 

https://mqa-internet.doh.state.fl.us/MQASearchServices/NursingPrograms
https://mqa-internet.doh.state.fl.us/MQASearchServices/PrescriptionPadVendors
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2.7 Medical Marijuana Qualified Physician  

The Medical Marijuana Qualified Physician search portal includes a search function to identify 
physicians qualified to recommend medical marijuana in Florida. You may search by 
Specialty/Certification, Name, Location and Status. A list of relevant results is provided to 
select from. 
 

 
 

2.8 New Licensed Health Care Practitioners and Facilities  

The New Licensed Health Care Practitioners and Facilities search allows users to look up 
licensed health care practitioners and facilities across various professions and regions within 
Florida. This service helps residents, patients, and organizations verify new licenses and 
ensures that healthcare providers meet Florida's regulatory standards. 

 

 
 

 

 

 

 

 

 

 

 

https://mqa-internet.doh.state.fl.us/MQASearchServices/MedicalMarijuanaPhysician
https://mqanewpractitionersearch.azurewebsites.net/
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3. MQA’s Data Download Portal 

MQA’s Data Download Portal is your resource for accessing a wide range of publicly available 
data and tools. Designed to be user-friendly and efficient, this platform aims to support the need 
for data for research, work projects, or other data needs. This guide will help you navigate the 
portal’s features and maximize its capabilities.  

Please be aware that the Florida Department of Health does not provide technical support for the 
portal. However, this guide is intended to serve as a comprehensive resource to assist you in 
exploring and utilizing the platform independently.  

3.1 Sign On 

Sign-on is a critical feature of the Data Download Portal and ensures that our data team can 
better understand how users interact with the platform and utilize the available data. As the 
portal undergoes updates to include new and expanded information that was not previously 
accessible, tracking user engagement allows us to evaluate its effectiveness and usability. 
 
Additionally, as updates and enhancements are made to the portal, having a sign-on system 
allows us to communicate directly with users, providing timely notifications about changes, 
new data sets, and other relevant updates. This ensures users remain informed and can fully 
benefit from the portal’s evolving capabilities. 

 

 
 

 
 

 

https://data-download.mqa.flhealthsource.gov/
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3.2 Home 

Here, you’ll find general information about accessing public data provided by the Florida 
Department of Health, in compliance with Chapter 119, Florida Statutes. Data files are 
updated daily and formatted as ASCII text, pipe-delimited for use in spreadsheet, word 
processing, or database applications. 
 
Note: Some information, such as financial or medical records and Social Security numbers, is 
confidential and excluded. Users are responsible for managing downloads, as technical 
support is not provided. 

 

 
 

3.3 Licensure Data  

The Florida Department of Health provides licensure data through the Licensure Data 
Download, including the license status, mailing address, and email address for health care 
practitioners and establishments licensed in Florida. The specific columns provided can be 
found in the metadata file. The user has the option to select “All Professions” or a specific 
profession. Users can then download either “All Statuses” or only “Currently Licensed”. The 
data is returned as a compressed pipe (|) delimited text file and, for the most part, can be 
imported into Microsoft Excel.  
 
To assist with understanding the data structure, metadata files are also available. These files 
provide details about the fields and formatting of the licensure data, ensuring users can 
efficiently analyze and integrate the information into their workflows. 
 
Important Note: Selecting "All Professions" will generate a file containing over a million 
records, which exceeds Excel's capacity and must be imported into database software for 
analysis. For a full list of all professions, see Professions Available. 

 

https://data-download.mqa.flhealthsource.gov/LicensureData
https://data-download.mqa.flhealthsource.gov/LicensureData
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3.4 Profile Data  

This resource is designed to help users access and analyze the key profile data for licensed 
practitioners in Florida. 
 
The Practitioner Profile Data Download provides detailed information on healthcare 
practitioners, including certifications, staff privileges, faculty appointments, disciplinary actions, 
and more. The specific columns provided in each download can be found in the metadata file 
associated with that file. This data is only required for certain professions, including: 
• Medical Doctors 
• Osteopathic Physicians 
• Podiatric Physicians 
• Advanced Practice Registered Nurses 
• Chiropractic Physicians 

 
The data available in the Practitioner Profiling tables can be used to find more specific 
information about a practitioner besides contact information. It can be used to find a group of 
practitioners that meet certain factors, such as education history or specialty. This can then be 
used to either find a certain type of practitioner, or to find more information about a group of 
practitioners. 
 
The profiles contain self-reported data, which may not be verified by the Department, and 
includes essential details such as education, current practice and mailing addresses, legal 
actions, and any disciplinary actions. Medical malpractice information and federal criminal 
history is not included. Each profile table contains information about the practitioner including 
license number. This license number can be used to match to the Profile Master Table to find 
out other information like contact information. A practitioner may have multiple entries on each 
table. For example, if a practitioner has multiple specialties, they will appear twice on that file. 

 
The data required to be provided by the practitioner includes: 
• Practitioner's education and training, including other health related degrees, professional 

and post graduate training specialty 
• Practitioner's current practice and mailing addresses 
• Practitioner's staff privileges and faculty appointments 
• Practitioner's reported financial responsibility 
• Legal actions taken against the practitioner 
• Board final disciplinary action taken against the practitioner 

https://data-download.mqa.flhealthsource.gov/ProfileData
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• Any liability claims filed against podiatric physicians which exceed $5,000 
• Any liability claims filed against allopathic and osteopathic physicians which exceed 

$100,000. 
 

The data provided may also include optional information such as committees, memberships, 
and publications.  
 

 
 

3.5 License Status  

The License Status Data Download provides access to a focused subset of licensure data for 
verification purposes. This dataset includes information on the status of healthcare licenses, 
such as active, inactive, suspended, or revoked, making it a valuable tool for verifying a 
provider’s legal standing, ensuring compliance with state regulations, and supporting 
credentialing processes for healthcare organizations and individuals. 
 
This resource is designed to facilitate efficient access to critical licensure status information to 
meet your verification and compliance needs. 
 
The License Status tab varies from the Licensure Data tab in that the License Status tab only 
provides license information related to license status and issue date. It does not provide any 
contact information. 
 

 

https://data-download.mqa.flhealthsource.gov/LicenseStatus


MQA Search Services and Data Download User Guide   
System Support Services  

Division of Medical Quality Assurance  
 

12 
 

 

3.6 Authorized to Order Medical Cannabis and Low THC Cannabis  

The Authorized to Order Medical Cannabis and Low THC Cannabis Data Download includes 
information about healthcare providers who are authorized to prescribe medical cannabis and 
low-THC cannabis. Its purpose is to provide transparency and access to data regarding 
qualified practitioners in the state, which can help patients and caregivers in identifying 
legitimate sources for medical cannabis prescriptions.  

 

 

3.7 Administrative Complaints  

The Administrative Complaints Filed within the Last 30 Days dataset in Florida contains 
information about recent complaints against regulated professions and businesses. Its 
purpose is to provide transparency regarding administrative actions and to inform the public 
about potential issues within various industries. This data can help consumers and 
professionals stay informed about any administrative actions that might affect them.  

 

 

 

3.8 Pain Management Clinic Report  

The Pain Management Clinic Report aims to collect and analyze data on pain management 
services, focusing on the quality of care and treatment patterns in clinics. This report supports 
regulatory oversight, enhances patient safety, and informs policy decisions related to pain 
management practices.  
 

https://data-download.mqa.flhealthsource.gov/AuthtoOrderMedicalandLowTHCCannabis
https://data-download.mqa.flhealthsource.gov/AdminComplaint
https://data-download.mqa.flhealthsource.gov/PainManagementReport
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3.9 Pharmacy/Pharmacist  

The Listing of Newly Licensed or Closed Pharmacies provides updated information about 
pharmacies that have recently received their licenses or have closed. Its purpose is to ensure 
transparency and keep the public informed about the status of pharmacies, which is crucial for 
patient safety and accessibility to medications.  
 

 

 

4. Tips for Working with the Data 

The MQA Data Download Portal is a resource for accessing a wide range of publicly available 
data and tools. The portal aims to support your need for data for research, work projects, or other 
data needs. Below is information on some techniques for working with the data available through 
the portal. 
 

4.1 Metadata Files 
For each downloadable file, there is an associated Metadata document. This document shows 
the information available in the file as well as the field (column) name and associated field 
description. This document makes it easier to see what data is located in each file so that the 
user can download the one that is most suitable to their needs. 

 
 
 
 

https://data-download.mqa.flhealthsource.gov/PharmacyPharmacist
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4.2 Data File Format 
 
All files from the Data Download Portal are only available as a pipe-delimited text file. 
 
Each file available to download is hyperlinked from the site. When you click on the hyperlink, 
the file will download as a text file (.txt). 
 
If you open the file, it will look something like this: 

 

 
 

To use the file, you must first save it so that you can later find it. To do this click File and Save 
As. 

 

 
 

By saving the file in a known location, you can easily import it into a software that you use to 
interact with the file. 

 
 

4.3 Large Data Sets 
 

Because of the size limitation, certain files cannot be imported into Excel and must be 
accessed using database software. These are files with more than 1,000,000 rows.  
 

(a)  Licensure Data 
(i) All Professions (Both Currently Licensed and All Statuses) 
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4.4 Using Excel to Work with the File 
 

 After the file is saved, open Excel. Select the Data tab and then on the left side select From 
Text/CSV. 

 

 
 

Select the file from the saved location and click Import. You will need to change the delimiter 
to Custom and enter in the “|” symbol (Typically above the Enter Key on your keyboard). 
Check that the file has imported correctly and click Load. 

 

 
 

The Excel file will now contain the information from the text file as a table. If you do not want 
the information in table format, you can convert the file. To convert the table to an unformatted 
grid: 

 
a) Select the entire table by using Ctrl + A. 
b) On the Table Design tab, click on Convert to Range. This process may take a minute 

depending on the size of your file. 
c) Then on the Home tab, in the Editing section, click on Clear and then Clear Formats. 

 
The file can now be filtered and sorted as needed. 

 

4.5 Using Excel to Work with Multiple Files 
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To match supplementary profile data to the License Profile Master Table, you can use Excel 
to combine the two files into one.  

 
1) LOAD 

 
(a) The first step is to follow the process above to load the first file. DO NOT CONVERT 

FROM A TABLE. 
(b) Next, start the import for the second file (any of the specific profile pages, like 

Education), but do not click Load.  
(c) Instead, you are going to click on the Transform Data button that is located next to 

Load. 
(d) The Power Query Editor will open. 
(e) Because the pro_cde and lic_id both need to match, you can combine them into 

one column on both files. 
(f) Under the Add Column tab, select Column from Examples. 
g) In the new column, write  ‘=’, and select the pro_cde column, enter a dash, and then 

click the lic_id column. This is shown in the example below. You will see the 
expected result in light gray for other rows. Click OK. The new column will be the 
last column on the right. If you prefer, you can move it to the first column location. 
 

h)  

 
 
 

 
 

i) You will need to duplicate these steps for the other file so that they can be matched. 
 

 
2) MERGE 

 
(a) You are now ready to merge the two files. 
(b) On the left side, make sure the second file or non-Master Table is highlighted. 
(c) On the Home tab, click on Merge Queries in the Combine Section. 
(d) A box will appear. The top section should be the profile file. 
(e) For the bottom section, select the License Profile Master Table. 
(f) Highlight the matching column on each sheet, in this case, the newly created 

custom column. 
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(g) Under Join Kind, select Left Outer. This will match any information from the 
profile table to the License Profile Master Table. This means if there is no match 
from the profile data to the License Profile Master, that row will only have 
information from the profile table. 

 

 
 

h) If you go to the far right, you will see the joined table. Click on the expand button 
and choose the columns that you want to display. 

i) Click the Close and Load button on the Home tab. 
j) This process may take a minute depending on the file size and number of 

matches. 
 

3) CONVERT 
 
The new merged Excel file will now contain the information from both text files as a 
table. If you want the information not in table format, you can convert the file. To 
convert the table to an unformatted grid:  
 

a) Select the entire table by using Ctrl + A. 
b) On the Table Design tab, click on Convert to Range. This process may take a 

minute depending on the size of your file. 
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c) Then on the Home tab, in the Editing section, click on Clear and then Clear 
Formats. 

 
      The file can now be filtered and sorted as needed. 

 

5. Professions Available 

MQA provides licensure data for the following professions. 
 
Board of Acupuncture 
• Acupuncturist 
• Acupuncturist Out-of-State Telehealth 

 
Board of Athletic Training 
• Athletic Trainer 
• Athletic Trainer Out-of-State Telehealth 
 
Board of Chiropractic Medicine 
• Certified Chiropractic Physician’s Assistant 
• Certified Chiropractic Physician’s Assistant Out-of-State Telehealth Pvdr 
• Chiropractic Faculty Certificate 
• Chiropractic Physician 
• Chiropractic Physician Out-of-State Telehealth Provider 
• Registered Chiropractic Assistant 

 
Board of Clinical Laboratory Personnel 
• Clinical Laboratories 
• Clinical Laboratory Personnel 
• Clinical Laboratory Technologist Out-of-State Telehealth 
• Clinical Laboratory Trainee 
• Clinical Laboratory Trainee Out-of-State Telehealth 
• Clinical Laboratory Training Program 

 
Board of Dentistry 
• Dental 
• Dental Expert Witness Certificate 
• Dental Hygienist 
• Dental Laboratory 
• Dental Radiographer 
• Dental Out-of-State Telehealth 
• Dental Residency Permits 
• Dental Teaching Permits 
• Dental Teaching Permits Out-of-State Telehealth 
• Dental Temporary Certificate 
• Dental-Health Access Dental 
• Non-Profit Corporations 
 
Board of Hearing Aid Specialists 
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• Hearing Aid Specialist 
• Hearing Aid Specialist Out-of-State Telehealth 
• Hearing Aid Specialist Trainee 
• Hearing Aid Specialist Trainee Out-of-State Telehealth 

 
Board of Massage Therapy 
• Massage Establishment 
• Massage Therapist 
• Massage Therapist Out-of-State Telehealth 
• Massage Therapy Apprentice 

 
Board of Medicine 
• Anesthesiologist Assistants 
• Anesthesiologist Assistants Out-of-State Telehealth Provider 
• Exempt Pain Management Clinic 
• Graduate Assistant Physician 
• Limited License Medical Doctor 
• Medical Doctor 
• Medical Doctor Expert Witness Certificate 
• Medical Doctor Limited to Cleveland Clinic 
• Medical Doctor Limited to Mayo Clinic 
• Medical Doctor Out-of-State Telehealth Provider 
• Medical Doctor Public Health Certificate 
• Medical Doctor Public Psychiatry Certificate 
• Medical Doctor Restricted 
• Medical Doctor Visiting Faculty Certificate 
• Medical Doctor – Temporary Area of Critical Need 
• Medical Faculty Certificate 
• Office Surgery Registration 
• Pain Management Clinic 
• Physician Assistant 
• Physician Assistant Out-of-State Telehealth Provider 
• Physician Assistant Temp. Cert. Area of Critical Need 
• Registration for Resident/HSE Physician 
• Temporary Military Platform Medical Doctor 

 
Board of Mental Health Professions 
• Licensed Clinical Social Worker 
• Licensed Clinical Social Worker Out-of-State Telehealth 
• Licensed Marriage and Family Therapist 
• Licensed Marriage and Family Therapist Out-of-State Telehealth 
• Licensed Mental Health Counselor 
• Licensed Mental Health Counselor Out-of-State Telehealth 
• Provisional Clinical Social Worker Licensee 
• Provisional Clinical Social Worker Licensee Out-of-State Telehealth 
• Provisional Marriage and Family Therapist Licensee 
• Provisional Marriage and Family Therapist Licensee Out-of-State Telehealth 
• Provisional Mental Health Counselor Licensee 
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• Provisional Mental Health Counselor Out-of-State Telehealth Licensee 
• Registered Clinical Social Worker Intern 
• Registered Clinical Social Worker Intern Out-of-State Telehealth 
• Registered Marriage and Family Therapist Intern 
• Registered Marriage and Family Therapist Intern Out-of-State Telehealth 
• Registered Mental Health Counselor Intern 
• Registered Mental Health Counselor Intern Out-of-State Telehealth 

 
Board of Naturopathic Medicine 
• Naturopathic Physician 
 
Board of Nursing 
• Advanced Practice Registered Nurse 
• Advanced Practice Registered Nurse – Temp Certificate Area of Critical Need 
• Advanced Practice Registered Nurse Out-of-State Telehealth Provider 
• Certified Nursing Assistant 
• Certified Nursing Assistant Out-of-State Telehealth Provider 
• Licensed Practical Nurse 
• Licensed Practical Nurse Out-of-State Telehealth Provider 
• Nursing Education Program – PN 
• Nursing Education Program – RN  
• PN Remedial Course 
• Registered Nurse 
• Registered Nurse Out-of-State Telehealth Provider 
• RN Remedial Course 

 
Board of Nursing Home Administrators 
• Nursing Home Administrator 
• Nursing Home Administrator Provisional License 

 
Board of Occupational Therapy 
• Occupational Therapist 
• Occupational Therapist Out-of-State Telehealth 
• Occupational Therapy Assistant 
• Occupational Therapy Assistant Out-of-State Telehealth 
• Occupational Therapy Doctoral Capstone Experience 

 
Board of Opticianry 
• Apprentice Optician 
• Apprentice Optician Out-of-State Telehealth 
• Optical Establishment Permit 
• Optician  
• Optician Out-of-State Telehealth 

 
Board of Optometry 
• Optometric Faculty Certificate 
• Optometrist 
• Optometrist Out-of-State Telehealth Provider 
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• Optometry Branch Office 
 

Board of Orthotists and Prosthetists 
• Orthotic Fitter 
• Orthotic Fitter Assistant 
• Orthotic Fitter Assistant Out-of-State Telehealth Provider 
• Orthotic Fitter Out-of-State Telehealth Provider 
• Orthotic Resident 
• Orthotic Resident Out-of-State Telehealth Provider 
• Orthotic-Prosthetic Resident 
• Orthotist 
• Orthotist Out-of-State Telehealth Provider 
• Pedorthist 
• Pedorthist Out-of-State Telehealth Provider 
• Prosthetic Residents 
• Prosthetic Residents Out-of-State Telehealth Provider 
• Prosthetist 
• Prosthetist Out-of-State Telehealth Provider 
• Prosthetist-Orthotist 
• Prosthetist-Orthotist Out-of-State Telehealth Provider 

 
Board of Osteopathic Medicine 
• Osteopathic Faculty Certificate 
• Osteopathic Graduate Assistant Physician 
• Osteopathic Limited License 
• Osteopathic Physician 
• Osteopathic Physician Expert Witness Certificate 
• Osteopathic Physician Out-of-State Telehealth 
• Osteopathic Resident Registration 
• Osteopathic – Temporary Area of Critical Need 

 
Board of Pharmacy 
• Consultant Pharmacist 
• Consultant Pharmacist Out-of-State Telehealth Provider 
• Nonresident Sterile Compounding 
• Nuclear Pharmacist 
• Nuclear Pharmacist Out-of-State Telehealth Provider 
• Pharmacist 
• Pharmacist Intern 
• Pharmacist Out-of-State Telehealth Provider 
• Pharmacy 
• Pharmacy Technician Training Program 
• Registered Pharmacy Technician 

 
 

Board of Physical Therapy 
• Physical Therapist 
• Physical Therapist Out-of-State Telehealth 
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• Physical Therapist Assistant 
• Physical Therapist Assistant Out-of-State Telehealth 

 
Board of Podiatric Medicine 
• Certified Pod X-Ray Assistant 
• Podiatric Physician 
• Podiatric Physician Out-of-State Telehealth Provider 
• Podiatric Residency Program 
• Podiatric Resident Registration 
• Podiatric Resident Registration Out-of-State Telehealth Provider 

 
Board of Psychology 
• Limited License Psychologist 
• Limited License Psychologist Out-of-State Telehealth 
• Provisional Psychologist 
• Provisional Psychologist Out-of-State Telehealth 
• Psychologist 
• Psychologist Out-of-State Telehealth 

 
Board of Respiratory Care 
• Certified Respiratory Therapist 
• Certified Respiratory Therapist Out-of-State Telehealth 
• Registered Respiratory Therapist 
• Registered Respiratory Therapist Out-of-State Telehealth 
• Registered Student Exemption 
• Respiratory Care Practitioner by Exam 
• Respiratory Care Practitioner by Critical Care 
• Respiratory Care Practitioner by Critical Care Out-of-State Telehealth 
• Respiratory Care Practitioner by Non-Critical Care 
• Respiratory Care Practitioner by Non-Critical Care Out-of-State Telehealth 

 
Board of Speech-Language Pathology and Audiology 
• Audiologist 
• Audiologist Out-of-State Telehealth 
• Audiology Assistant 
• Provisional Audiologist 
• Provisional Audiologist Out-of-State Telehealth 
• Provisional Speech-Language Pathologist 
• Provisional Speech-Language Pathologist Out-of-State Telehealth 
• Speech-Language Pathologist 
• Speech-Language Pathologist Out-of-State Telehealth 
• Speech-Language Pathology Assistant 
• Speech-Language Pathology Assistant Out-of-State Telehealth 

 
Bureau of Emergency Medical Services 
• Emergency Allergy Treatment Licensee 
• Emergency Allergy Treatment Licensee Out-of-State Telehealth Provider 
• Emergency Medical Technician 
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• Emergency Medical Technician Out-of-State Telehealth Provider 
• Paramedic 
• Paramedic Out-of-State Telehealth Provider 

 
Public Safety Telecommunications 
• 911 Law Enforcement Officer 
• 911 Public Safety Telecommunicator 
• 911 Public Safety Telecommunicator Training Program 
 
EMS Providers 
• EMS Service Provider Air 
• EMS Service Provider ALS 
• EMS Service Provider BLS 
• Vehicle Permit (Aircraft) 
• Vehicle Permit (ALS) 
• Vehicle Permit (BLS) 
 
Council of Dietetics and Nutrition Practice 
• Dietetics/Nutritionist 
• Dietetics/Nutritionist Out-of-State Telehealth 
• Nutrition Counselor 
• Nutrition Counselor Out-of-State Telehealth 

 
Council of Electrolysis 
• Electrologist 
• Electrologist Out-of-State Telehealth 
• Electrolysis Laser Provider 
• Electrolysis Facility 

 
Council of Licensed Midwifery 
• Midwifery 
• Midwifery Out-of-State Telehealth 
• Temporary Midwife 

 
Office of Certified Master Social Workers 
• Certified Master Social Worker 
• Certified Master Social Worker Out-of-State Telehealth 

 
Office of Genetic Counseling 
• Genetic Counselor 
• Genetic Counselor Out-of-State Telehealth 
 
 
Nursing Home Administrators 
• Nursing Home Administrator 
• Nursing Home Administrator Provisional License 
 
Office of Medical Physicists 
• Diagnostic Radiological Physicist 
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• Diagnostic Radiological Physicist Out-of-State Telehealth 
• Medical Health Physicist 
• Medical Health Physicist Out-of-State Telehealth 
• Medical Nuclear Radiological Physicist 
• Medical Nuclear Radiological Physicist Out-of-State Telehealth 
• Medical Physicist in Training 
• Medical Physicist in Training Out-of-State Telehealth 
• Temporary Medical Physicist 
• Temporary Medical Physicist Out-of-State Telehealth 
• Therapeutic Radiological Physicist 
• Therapeutic Radiological Physicist Out-of-State Telehealth 

 
Bureau of Radiation Control 
• Rad Tech Approved CE Courses 
• Rad Tech Approved CE Providers 
• Radiologic Technology 
• Radiologic Technology Out-of-State Telehealth 
• Radiologist Assistant 
• Radiologist Assistant Out-of-State Telehealth 

 
Office of School Psychology 
• School Psychologist 
• School Psychologist Out-of-State Telehealth 

 
Other Professions (Historic or Telehealth Only) 
• Board Certified Assistant Behavior Analyst Out-of-State Telehealth 
• Board Certified Behavior Analyst – Doctoral Level Out-of-State Telehealth 
• Board Certified Behavior Analyst Out-of-State Telehealth 

6. Other Sites of Interest 

a) MQA Home Page 
https://flhealthsource.gov/ 

 
b) Links to Board Websites 

https://www.floridahealth.gov/licensing-and-regulation/index.html 
 
c) MQA Reports and Publications 

https://www.floridahealth.gov/licensing-and-regulation/reports-and-publications/index.html 
 
d) Other DOH Data – Statistics and Data 

https://www.floridahealth.gov/statistics-and-data/index.html 
 
e) Florida Department of Business and Professional Regulation 

https://www2.myfloridalicense.com/ 
 
 
 

 

https://flhealthsource.gov/
https://www.floridahealth.gov/licensing-and-regulation/index.html
https://www.floridahealth.gov/licensing-and-regulation/reports-and-publications/index.html
https://www.floridahealth.gov/statistics-and-data/index.html
https://www2.myfloridalicense.com/
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